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 Welcome to the world of 78K0R UZ Stick. 
  
You are now being navigated to the design environment 
of the 78K0R microcontroller for developing wireless 
network applications. Please follow the tutorial step by 
step. 
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[NOTES] 
The information in this document is subject to change without notice. No part of 
this document may be copied or reproduced in any form or by any means without 
the prior written consent of TESSERA TECHNOLOGY INC.. 
TESSERA TECHNOLOGY INC.. assumes no liability for infringement of patents 
or copyrights of third parties by or arising from use of a product described herein. 
This product is designed and manufactured with intention for use in evaluation 
and prototyping by engineers with knowledge of security, safety and reliability. 
TESSERA TECHNOLOGY INC.. would like to inform, that the standard quality 
assurance procedure(s) have not been fully applied to this product and its 
documentation and that TESSERA TECHNOLOGY INC.. cannot assure the full 
and error free function and/or the standard quality level. 
[CAUTION] 
This equipment should be handled like a CMOS semiconductor device. The user 
must take all precautions to avoid build-up of static electricity while working with 
this equipment. All test and measurement tool including the workbench must be 
grounded. The user/operator must be grounded using the wrist strap. The 
connectors and/or device pins should not be touched with bare hands. 
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1 Introduction 
 
 
 
Target Reader Software development engineers who wish to become familiar 

with the development environment of the 78K0R 
microcontrollers. It is assumed that the readers have been 
familiar with basics of microcontrollers, C and assembler 
languages, and the WindowsTM operating system. 

 
Purpose For readers to become familiar with the design environment 

and the application examples of wireless networks. 
 
 
Overview This manual consists of the following contents 
 
Chapter 1 Introductions 
              →Overview of this manual 
 
Chapter 2 Preparations 
              →Introduction of soft tools, and sample programs and installation 
 
Chapter 3 Experiences 
              → Guide to the basic operations of PM + and the integrated 

debugger using sample programs. 
 
Chapter 4 IEEE 802.15.4 MAC Sample Programs                                           
              → Learn sample programs, which utilize the MAC library 
 
Chapter 5 Mode Setting of the 78K0R UZ Stick 
  → Explanation of switch setting. 
 
 
Trademark Microsoft and Windows are either registered trademarks or 

trademarks of Microsoft Corporation in the United States and/or 
other countries. 
Adobe and Acrobat are trademarks of Adobe Systems 
Incorporated (Adobe System Incorporated). 
Other company names and product names that appear in this 
document are the registered trademarks or trademarks of their 
respective companies. 
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2 Preparations 
 

 
This chapter introduces the development environment and describes how to 
install the sample programs. The sample program can be tested on this 
hardware platform of the evaluation kit. 
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2.1 Development Tools, Sample Programs, and the MAC Library 
 
 
 

 
This section outlines the development tools, sample programs and the MAC 
library used in this tutorial.  

 

2.1.1 Integrated Development Environment PM + V6.30 
This is a project manager, where you work for editing the source code, 
compiling it, and initiating the debugger. The project manager works on MS 
Windows 2000 or XP.  

 

2.1.2 Device file DF781188 V3.00 
A device file contains an MCU specific information. It instructs the 
development tools what kind of an MCU the tools shall work for.  

 

2.1.3 C Compiler CC78K0R W1.20 : Code size limited version 
This is a free compiler for the 78K0R microcontrollers. The object code size 
is limited to 64 Kbytes. It works on MS Windows 2000 or XP. 

 

2.1.4 Assembler RA78K0R W1.10 : Code size limited version 
This is a free assembler for the 78K0R microcontrollers. The object code 
size is limited to 64 Kbytes. It works on MS Windows 2000 or XP. The 
RA78K0R Assembler Package contains Structured Assembler 
Preprocessor, Assembler, Linker, Object Converter, Librarian, and List 
Converter. 
 

2.1.5 78K0R integrated debugger ID78K0R-QB V3.40 
The Integrated Debugger ID78K0R-QB offers a debug environment on 
your PC, where the MS Windows 2000 or XP runs, if the 78K0R UZ Stick is 
connected to the PC with USB. The USB I/F accesses to the OCD, On 
Chip Debug, interface on the microcontroller.  

 

2.1.6 78K0R Starter Kit Setting 
If you forget about the security ID or if you set On-Chip Debug Option Byte 
to “disable on-chip debug function”, you can erase the flash memory by 
using this starter kit.   
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2.1.7 USB driver  
This is a software driver for PC to access to the USB interface of the 
78K0R UZ Stick.  

 

2.1.8 The RF Test Program 
The RF Test Program is used in [chapter 2 Experiences]. 
 
The RF Test Program is provided in the form of the C source codes.  
 
If you wish to tailor the RF Test Program to meet your specific needs, you 
can edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on 
to the microcontroller for further debugging on the project manager PM +. 
 
Alternatively, if debugging is not required, you can make a release build to 
achieve a new hex file, on the project manager PM +. 
 

As a general remark, please respect your local regulation of 
electro-magnetic emission. In general, it is suggested to use the 78K0R UZ 
Stick in a radio anechoic chamber. 
 
 

2.1.9 IEEE 802.15.4 MAC Library 
The IEEE 802.15.4 MAC Library offers an executable object-code library of 
the MAC stack specified in the IEEE 802.15.4. Please refer to the MAC 
Library manual for further details. 
 

2.1.10 The MAC Sample Program : Text Chat Program 
The MAC Sample program is developed to provide with a simple example 
to construct a star network utilizing the IEEE 802.15.4 PHY/MAC standard. 
 
The MAC Sample Program offers, 
1). Designation of a network coordinator in a star configuration 
2). Text chat between a coordinator and an end device 
 
To use the MAC Sample Program, you need to prepare at least two PC 
with a USB interface and two 78K0R UZ Stick.  
The MAC Sample Program is provided in the form of the C source codes.  
 
If you wish to tailor the sample program to meet your specific needs, you 
can edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on 
to the microcontroller for further debugging on the project manager PM +. 
However, because the USB connection to instruct operation to the program 
is occupied for the debugging purpose,  
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alternatively, you can make a release build to achieve a new hex file, on 
the project manager PM +. 
 

As a general remark, please respect your local regulation of 
electro-magnetic emission. In general, it is suggested to use the 78K0R UZ 
Stick in a radio anechoic chamber. 
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2.2 Installation of Software Development Tools 

 

 

2.2.1 Start-up of the installation CD-ROM 
 
The attached CD-ROM contains Development Tools, documents and sample 
soft ware.  
You can install it using an installer. 
 

2.2.2 Installation of the software development tools 
 
Please insert the CD-ROM in the drive. The installer will show up automatically. 
If it does not start automatically, please initiate it by double clicking the 
SETUP.EXE. 

 

 
 

 
<1> Readme First 

The contents of the CD-ROM, and some notes are available. 
Please read it at first. 

<2> Install… 
Click “Install” to start installation of development tools. 
For details, please refer to the next section. 
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<3> Documents 
Manuals of development tools and the evaluation kit are available in PDF 
files. 
When this button is clicked, the WWW browser will start. Adobe® Acrobat® 
Reader is available in the CD-ROM. 

     
<4> Sample Program 

Click this button to start the WWW browser for the sample program and the 
tutorial. 

<5> Link to NEC Electronics Microcontrollers   
Click this button to start the WWW browser display the link to the NEC 
Electronics Microcontroller web site 
(http://www.necel.com/micro/index_e.html) 
The NEC Electronics Microcontroller web page provides with the latest 
product/tool information and FAQs.   

<6> Exit  
Terminate the setup. 
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① Select products that you need to install. 

(as default, all the products that you need to use the demostration kit 
are selected.) 

"Explain" area displays an explanation of the selected product. 
To change the installation destination, click  Browse…  . 

 
When all the settings are completed, click  Install…  .  
 

* In this document, it is assumed that users install the programs under "NEC 
Electronics Tools" directory (default installation directory). Users can find the 
tools by selecting “Start Menu” -> "Programs" -> "NEC Electronics Tools".  
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② Click  OK  when "Install" confirmation dialog box is opened. 
 

 
 
 

③ Read "software license agreement" and click  Yes  for continuing the
 installation. To stop the installation, click  No  .  
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④ Enter the product ID, and click  Next  . 
* The product ID is available on the“README.HTML” or the other sheet. 

 

 
 
 

⑤ It starts copying the files.  
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⑥ Click  Next  when "Select Files" installation wizard dialog opened. 

 
 

 
⑦ When the installation is completed, the following dialog opens. 

Click  OK  .  
 

 
 
 

⑧ "NEC Electronics Starter Kit Virtual UART" USB driver must be install
ed on PC before you connect to 78K0R UZ Stick. 

 
Install the USB driver by referring "2.4 USB Driver".  
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 Notes on the installation authority  
To install this tool in Windows 2000 or XP, the authority of a administrator is 
necessary. Therefore, please login as a administrator. 
 
 Notes on the install-directory  
Please do not use 2-byte characters, such as umlaut in the directory name, 
where the product is to be installed. 
 
 Note on the version of Windows  
If the language of the Windows is not English, a file transfer error during 
installation might be observed. In this case, please abort the installation in 
the language, and re-install it in an English version of Windows. 
 

The identical problem may be observed, if a language other than English is 
specified as the system language in the “Regional Settings Properties” tab. 
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2.2.3 Uninstall 
 
<1>  Start "Add /Remove Programs" in the Control Panel. 

(Example here is based on Windows2000) 
 

 
 
<2>  Select the tool that you want to uninstall from the list displayed in 

"Install/Uninstall" and click [Add/Remove...]. 
 
 
<3>  A dialog box for confirming deletion of files will be displayed.  Click    

Yes   .  Deleting of the files will be started. 
 

 
 

 
<4>  When the completion message is displayed, click    OK   . 

 
Caution: 
Deletion of some files may be asked during uninstallation.  Normally, 
deletion of these files causes no problem.  

 
<5>  This completes uninstalling this tool. 
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2.2.4 File Configuration in PC 
 

Software Development Tools are installed in "C:¥Program Files¥NEC Electronics 
Tools" on default setting. 
When you use the tools, please open the tools from [Start menu] -> 
[Programs]->[NEC Electronics Tools]. 
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2.3 Sample Environment 

 

 

 
This section explains the overview and preparation of sample programs. 

You need to install the sample programs on your system first before using them. 
 

How to install the sample programs and where they should be intalled on your 
system will be explained. 
 
 
 

 
 



- 22 - 

Click the [78K0R UZ Stick Sample 
programs] link you can also 

download the [Tutorial Guide] 

2.3.1 Installation of the sample programs 
 
Insert the CD-ROM disk in the CD-ROM drive of your PC. The [NEC Electronics 
Microprocessor Development Tools Setup] screen automatically appears.(if this screen does 
not appear automatically, start setup.exe from Explorer. etc.) 
Press the  Sample Program  button to start the WWW browser, and then click the [78K0R 
UZ Stick Sample Programs] link.  

   

 
 

 
 

 

 

 

 

 

 

 

 

 

 

When[78K0R UZ Stick Sample Programs] is clicked, the following download 
confimation window appears. 

 

The WWW 
browser starts up. 
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Please click the Open button. 
In case of windows 2000, 

you will see the [Security Warning] window. Please click  Run . 
 

 
 

 
 

InstallShield wizard for TK-Sample Program starts up  
Please click  Next. 
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License agreement screen is displayed. 

Please select "I accept the terms in the license agreement".and click Next. 
 

 
 

 
 

Please click Finish. 
 
 
The sample programs are installded. 
The sample program "TK78K0R.EXE" with self-extract file is also intalled. When 
you need to use the original sample programs, you can extract the file 
"C:¥TK78K0R.EXE". 
 
When you uninstall the sample program. 
Please use "Add /Remove Programs" in the Control Panel. 
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2.3.2 File Configuration of the sample program 
 
The sample programs ware the following folders. 
 

 
 
 
 
 
 
 
 
 
 
 

TK78K0R 

SAMPLE_UZStick 

 

78K0R_UZSTICK_RF_Test      The sample program used in chapter 3. 

The packet error rate and received signal 

strength indication are monitored.  

78K0RUZSTICK_MAC_Sample  This sample program uses MAC 

library.The text message is transmitted 

and it receives it. 
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2.4 USB Driver 
 
 
 
 
You need to install “NEC Electronics Starter Kit Virtual UART” in your PC.  
 
When 78K0R UZ Stick is used, it is necessary to install the “NEC Electronics 
Starter Kit Virtual UART” driver in the host machine. Please install the driver 
according to the following procedures with appending CD in the drive. 

 
"Starter Kit USB Driver" must be installed on the PC. If not, please refer to "2.2 
Installation of Development Tools" to install the driver first.  

 
Attention  Do not use a USB hub for connecting 78K0R UZ Stick. 

 
 
Depending on the version of Windows OS, the installation will be differed.  
Please check your Windows version, and follow the instructions 
   - Windows XP   -> "2.4.1 Installation on Windows XP" 
   - Windows 2000 -> "2.4.2 Installation on Windows 2000" 
After the installation, go to "2.4.3 Confirmation of the installation" 
 
 

8
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2.4.1 Install to Windows XP 
 

１． Once the 78K0R UZ Stick is connected with USB, the "Found New Hardware Wizard" 
will be started. Select "No, not this time" and click  Next >  .  

 

 
 
 
２． Select "Install from a list or specific location" and click  Next >  .  
 

 

Select "Install from a list or specific 

location" 

Click "Next" 
 

Click "Next" 

Select "No, not this time" 
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３． Select "Search for the best driver in these locations.” , check "Include this location in 
the search:", and then click "Browse..." to select the driver directory path. The path 
should be "C:¥Program Files¥NEC Electronics Tools¥TK-driver" as default installation. 
If the installation directory is not default, then select "TK-driver" under the installation 
directory.  
Click  Next >  . 

 

 
 

 

４． If the following dialog is opened, click  Continue Anyway  .  
 

 
 
 

Click "Next" 

Click "Continue Anyway" 

Select the driver directory 
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５． The installation of "NEC Electronics Starter Kit Virtual UART" driver is completed.  
Click  Finish  . 

 
 

 
 

６． Go to "2.4.3 Confirmation of the installation". 
 

 

Click "Finish" 
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2.4.2 Install to Windows2000 
 

１． Once the 78K0R UZ Stick is connected with USB, the "Found New Hardware Wizard" will 
be started.  
Select "No, not this time" and click  Next >  .  

 
 
 

 
 

 

Click 
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２． Select "Search for a suitable driver for my device". 
Click  Next >  .  

 

 
 
 

３． Select "Specify a location". 
Click  Next >  .  

 
 

 
 
 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

Click "Next" 

Select "Search for a suitable driver for my 

device" 

Click "Next" 

Select "Specify a location" 
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４． Select the driver directory path. The path should be " C:¥Program Files¥NEC 
Electronics Tools¥TK-driver " as default installation. 
If the installation directory is not default, then select "TK-driver" under the installation 
directory.  
Click  OK  . 

 

 
 
 
 
 
 
５． Click  Next >  .  
 

 

 
 

 

 

Click "Next" 

Click "OK" 

Select the driver directory 
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６． The installation of "NEC Electronics Starter Kit Virtual UART" driver is completed.  
Click  Finish  . 
 

 
 
 
 
 
７． Go to "2.4.3 Confirmation of the Installation". 

 

 

Click 
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2.4.3 Confirmation of the installation  
 
Please confirm “NEC Electronics Starter Kit Virtual UART(COMx)” in the device 
manager of system in the control panel of the MS Windows.  
 
 

Device Manager 

 
 
The screen above shows that the COM port number is "COM8". If ID78K0R-QB is 
not in use, you can use this port number for connecting 78K0R UZ Stick. 

When you change the USB port Connection, the COM port number will be 
changed as well. 

 
 

CAUTION 
・Do not do “Hardware Modification Scan” when you communicate with the target device. 

 
 

Confirm " NEC Electronics Starter 

Kit Virtual UART (COMx)" is 
displayed. 
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3 Experiences 
 
 
Now you are ready to experience the operation of the 78K0R UZ Stick using the 
integrated development environment, PM +. 
 
As a program for the 78K0R/KE3, the RF test program (RF_Test) which you 
installed in "2.3.1 Installation of the sample programs" is used. 
You use two of 78K0R UZ Stick. One is the stand-alone system with USB power 
supply. Another is connected to the debugger and run user programs. By building 
the sample programs and operating with ID78K0R-QB, you can understand the 
basic operation of the development tools (PM+, ID78K0R-QB) and the basics of 
the project files that you need when you develop application programs. 
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The overall flow is as follows. 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Starting integrated debugger (ID78K0R-QB) 

Executing program 

Stopping program 

Operation 

Terminating integrated debugger (ID78K0R-QB) 

Loading workspace (project) 

Creating execution format 

Reviewing Linker, Compiler option, Debug setting 

78K0R UZ Stick setting 

Starting PM + 

Terminating PM + 
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3.1 Starting PM + 
 
 

 

In the Windows Start menu, select [Programs]->[NEC Electronics Tools]->[PM + 
V6.30] 

 
 
 
 
 

 
 
 
 
 

PM + start up 
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3.2 Introduction to PM + 
 
 
 
In PM +, application programs and environment setting are handled as a single Project, and series of actions 

such as program creation using the editor, source management, build, and debugging are managed. 

Also, one of more project files is managed together as a workspace. 

 

 

 

 
 
 
 
Project window A window in which project names, source files, and include file are displayed using a 

tree structure. 

Output window A window in which the build execution status is displayed. 

 

For details regarding menu bars and tool bars, refer to the PM + User’s Manual. 

 

Project window Output window 

Tool bar 
Menu bar 
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What is a project? 

A project is the unit in which PM + executes management, and refers to an application system 

and environment development based on PM +. 

PM + complies project information and saves it in a “project file”, from which it is then referenced. 

 

What is a project file? 

A project file is a file to which information such as the source file to be used in the project, the 

device name, the tool options for complying, and the editor and debugger to be used have been 

saved as “project information”. 

The file name format is “ΔΔΔΔprj”. 

Project files are created in folders that are set when creating new workspaces. 

 

What is a project group? 

A project group is a group comprised of a number of projects in an application system. 

The target devices of each project that can be registered to one project group must be the 

same. 

 

What is a workspace? 

A workspace is the unit used to manage all the projects or project group required for one 

application system. 

The file name of multiple project files is saved to a workspace file for referencing. 

The file name format is “ΔΔΔΔprw”. 
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3.3 Loading Workspace (Project) 
 
 

 
In this section, you will use the workspace that you created in "2.3.1 Installation of 
the sample programs" 
For creating a new workspace, refer to "3.15 Creating a new PM + workspace 
(project)". 
The workspace has information about the build environment for the sample 
programs. 
Select "File" on menu bar and "Open Workspace…". 
Then, select 
“C:¥TK78K0R¥SAMPLE_UZStick¥78K0R_UZSTICK_RF_Test¥RF_Test.prw” . 
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“RF_Test.prw”and then press the  Open  button. 

 
 

 

 
 
 

Open the folder in which the 

sample program is located. 

Workspace file name :RF_Test.prw 

Project group 

Project 

The “RF_Test.prw” workspace 

file is read 
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3.4 Configuration of Linker Option 
 
 
The linker options have been set by the project file. However, some option settings will be 
covered in this section because the linker option settings are important for debugging. 
Following three settings are covered specifically. 
  - Outputs from debugging 
  - On-chip debug (bytes, security ID) 
  - Watchdog timer 
 
Select "Tools" on menu bar, then "Linker options". 
 

3.4.1 "Output1" Tab 
Select "Output1" tab on "Linker Options" window, and see following settings. 
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  - Load Module File settings 

Check "Output Symbol Information". 
This enables to do source level debugging (setting break points, monitoring variables in 
watch window, etc). 
Also, you can specify the load module file name.  
 

  - On-Chip Debug Option Byte 
Check "On-Chip Debug Option Byte". Enter "85" in "Control value". This setting enables 
the on-chip debugging function of the microcontroller. 
For details of "Control value", refer to the user's manual of 78K0R/KE3 (U17854E). 
See "Start address" is set to "3FC00", and "Size" is set to "1024". 
These settings reserve the memory address area for the monitor program (the flash 
memory area that the debugger uses for on-chip debugging). 
In this case, the "Control value" is allocated to the address of C3H in flash memory, and 
FFH is set to the next address. Because of this, the following areas could not be set the 
segments. 
<Address area that reserved by on-chip debugging> 
  - 2H, 3H 
  - CEH-D7H 
  - From the address set in "Start address" to the byte set in "Size" 

 
  - Security ID 

Check "Security ID", and enter the security ID which is a unique ID code (10 bytes) to 
authenticate when the debugger is launched.  
The security ID is stored in the flash memory (C4H-CDH), and checked if it is the same 
as the code entered in Linker options dialog when the debugger is launched. 
The debugger will not be launched when the security ID is unmatched. By using this 
function, you can secure the programs from leaks. 
If you do not need to set the security, it is recommended to set the security ID 
"FFFFFFFFFFFFFFFFFFFF" as this is the initial code. 

 
If you forget about the security ID (stored in the address of C4H-CDH) or if you set wrong 
on-chip debug option byte, you will not be able to use the debugger (ID78K0R-QB). 
To solve this, you can use the "78K0R Starter Kit Setting" for changing the setting to initialize 
the flash memory at the time debugger launched. 
For details, refer to "3.9 Starting integrated debugger (ID78K0R-QB)". 
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3.4.2 "Output2" Tab 
Select "Output2" tab on "Linker Options" window, and see following settings. 
 

 
 
  - User Option Byte 

Check "User Option Byte", and then enter "00FFFF". Here, you can do the 
setting of watchdog timer, low-voltage detector, and system reserved 
memory area. The 3 bytes you entered are stored at C0H-C2H on flash 
memory: 
  - C0H: setting for watchdog timer 
  - C1H: setting for low-voltage detector 
  - C2H: setting for system reserved memory area (must be set as FFH) 
This time, you disabled the watchdog timer and the default start function of 
low-voltage detector. 
For details, refer to the user's manual, 78K0R/KE3 (U17854E). 
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3.5 Configuration of Compiler Option 
 

 
The compiler options have been set by project file. However, because some compiler options 
are useful, following three settings are covered specifically in this section. 
  - Setting for Define Macro 
  - Enable C++ comments 
  - Use multiplier and divider 
Select "Tools" on menu bar, then "Compiler options". 
 

3.5.1 “Preprocessor” Tab 
 
As "Define Macro", three macros, CPU78K0R, F0114664, and MAC_ADDR=0x0001, are set.  
These regard to "ifdef" statement in the source code. 
"MAC_ADDR=0x0001" indicates that the MAC short address is "0001" as the wireless node. 
(Also the 3rd - 4th byte of extended address from the upper side is set to 0x0001.) 
 
Enter "include" in "Include Search Path" field. 
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3.5.2 "Extend" Tab 
Select "Extend" tab, and check "Enable C++ Comment". 
This setting allow you to use the C++ comment using "//". 
It is useful feature when developing code. 
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3.5.3 "Startup Routine" Tab 
 
Select "Startup Routine" tab, and check "Using Library" and "Using 
Multiplier/Divider". The 78K0R/KE3 has feature of multiplier/divider to increase 
those calculation speed. 
 

 
 

 
 



- 48 - 

 

3.6 Configuration of Debugger setting 
 

 
 
 
Please Choose [Tool] -> [Debugger Setting] at the pull-down menu. 
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Check if "ID78K0R-QB V3.40 78K0R Integrated Debugger" is selected on "Debugger". 
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3.7 78K0R UZ Stick Settings 
 

 
Please set the switches on the 78K0R UZ Stick as follows. 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
  
After the switch settings are completed, connect the PC to USB connector on 
78K0R UZ Stick with USB cable. If the "Found New Hardware Wizard" is started, 
install USB driver with referring "2.4 USB Driver"". 

Switch Setting 
USB DBG 

POWER USB 

POWER Switch 

USB Switch 
DBG 

USB 
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3.8 Creating execution format 
 
 
 
Please go back to PM +. 

Please re-compile the project by clicking the  button at the menu bar. 
 

 

 

 
Build has been completed successfully.

Build process is  

executed 
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What is build ? 
Build is a function that creates an executable file, etc., from a source file registered to a project. 

PM + automatically performs compiling, linking, and other processing actions. 

On the second and subsequent build, PM + also automatically delects files that have been updated  

from the previous build processing, and complies and assembles only the relevant files, thereby reading 

the time required for build processing.  
 
 

What is rebuild ? 
Build compiles and assembles only the source files that have been updated since the previous 

time, whereas rebuild compiles and assembles all the source files.  

When setting, such as compiler options, have been changed, not build, but rebuild, must be  

Selected. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



- 53 - 

3.9 Starting integrated debugger (ID78K0R-QB) 
 
 
 
Please select the Debug button  ，of PM +, or in the menu, select [Build(B)]
→[Debug(D)]. 
 
 

 

 

 

  

 

 

 

 

If the debug button is not displayed, in the menu, select [Tool]→[Debugger 
Setting...]“ID78K0R-QB V3.30 78K0R Integrated Debugger” 

ID78K0R-QB is launched 
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"Configuration" dialog is opened. 
Enter "FFFFFFFFFFFFFFFFFFFF" (F x 20) in "ID Code", then click  OK  . 

 

 
Click  Yes  when the confirmation dialog for downloading load module file is opened. 
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NOTE: 

Completion of the download does not mean running the programs.  
To run the sample programs, go to "3.11 Executing program". 

 
 
 

ID78K0R-QB starts and downloading 
the program to flash memory. 

When the download is 
completed, the source code 

will be displayed 
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Normally, if communication with the CPU fails, the following error messages are output. 
 

 
 
If you observe the message please confirm the following items.  
 
 
 
1． Please confirm the switch on the 78K0R UZ Stick is set as follows. 
 
 
 
 
 
 
２． Please confirm the power LED1 is lighted. 
 
 
After checking the above items, start ID78K0R-QB again. 

 
 

Switch Setting 
USB DBG 

POWER USB 
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If the ID code is wrong, you may find the following messages on the display. 
 

 
 
 

The following "Configuration" screen is displayed when OK is pushed and input a correct ID 

code, please. 

 
 

If the setting of On-Chip Debug Option Byte is "Does not erase data of flash memory in 
case of failures in enabling on-chip debugging" and if you forget the security ID, you need to 
erase the CPU built-in flash memory. 
Ｔo erase the data in flash memory, do following steps. 

Double-click to open the file "exk0r32ocfg.exe" under the directory "C:¥Program Files¥NEC 
Electronics Tools¥TK-driver" (as the installation directory is default). 
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"78K0R Starter Kit Setting" starts. 
Set "Flash Memory" to " Erase flash memory at debugger start up ", then click 
"Setting". 

 
  

 
 
 
Restart the integrated debugger (ID78K0R-QB). 
 
When you could confirm the debugger is working, open "exk0r32ocfg.exe" again. 
This time, select "KEEP flash memory at debugger start up", then click Setting. 
(Because there is a limit of erasing times for flash memory, it is recommended to 
try not to erase flash memory many times) 
 
 
※ ID Code 
The ID Code is a mechanism to prevent an unwelcome third party from accessing your 
source code by initiating the debugger. Therefore, it is recommended to modify the ID Code 
from the default value to secure your original source code. However, once you modify it, then, 
if you forget the security ID or mistakenly over-write 0x00(value) to the address of 0xC3, the 
debugger ID78K0R-QB is unable to access to the CPU via OCD interface. In this case, you 
have to start over from erasing all data in the Flash EEPROM. Then, you can define the new 
ID Code. You may load your source code from the debugger with a load module file. 
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3.10 Introduction of integrated debugger(ID78K0R-QB) 
 
 
 
ID78K0R-QB displays the internal status of the CPU and controls monitor 
functions in the main window.  
The initial screen of ID78K0R-QB is as follows.  
 
< Main window＞ 

 
 
 
 

 
For more details, please refer to the user’s manuals of ID78K0R-QB. 

 
 

Status bar 

Menu bar 

Window display area 

Tool bar 
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3.11 Executing program 
 
 

If you click “GO” , the execution of the code will start. 
You can know it by the red bar at the bottom. 
However, because this RF Test Program requires a key input from HyperTerminal 
to set a test mode, the program is waiting for the key input, while the USB 
connection to PC is occupied with the debugger interface. To debug the each test 
mode of operation, you may modify the source code to specify a test mode by 
skipping the key input. The test modes will be explained later.  

 

 

 
 
When programs are running, the status bar will be red. 

Execute the program 
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3.12 Stopping program 
 
 
Now, you are going to stop the program. 
Press the ID78K0R-QB’s stop button , or in the menu, select [Run]→[Stop]. 

 

 

 
 
When the program stops, the status bar changes back to the original color. 
 

 
 
 

Stop the program 



- 62 - 

3.13 Terminating integrated debugger (ID78K0R-QB) 
 
 

Select "File" on menu bar, then "Exit". 
 

 
 
 
 

 
 

 
 
 
If you push the “Yes”, ID78K0R-QB is terminated after preserving a present 
environment.  
If you push the “No”, ID78K0R-QB is terminated without preserving a present 
environment. 

 

The Exit confirmation dialog box is 
displayed. 
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3.14 RF Test Program 
 
 
 

3.14.1 Procedure for one to one transmit/receive test 
 
1). Assumption here in this section is, you have two 78K0R UZ Stick. and you 

need identical number of PCs or one PC with more than one USB interface,  
Hereinafter, the 78K0R UZ Stick, which you have loaded programs to, is 
referred as to the "transmitter" and the other one with USB interface to the 
second PC for debugging is referred as to “receiver”, which send back the 
test result to the Transmitter. The receiver can work without PC, but now, 
you set this 78K0R UZ Stick to the debug mode. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

2). Preparation for Receiver 
 
Start PM+ with referring to Chapter 2, then open 
"C:¥TK78K0R¥SAMPLE_UZStick¥78K0R_UZSTICK_RF_Test¥RF_Test.prw". 
 
Select "Tool" on menu bar, then "Compiler options..." to open "Compiler Options" 
window. 
Select "Preprocessor" tab. 
The statement "CPU78K0R,F0114664,MAC_ADDR=0x0001" is in "Define Macro" 
field. 
Change the statement to " 

Receiver Debugger use. 

Execute ID78K0R-QB. 

Transmitter use as Stand alone. 

Execute terminal software. 

Short address : 0001 Short address : 0002 
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CPU78K0R,F0114664,MAC_ADDR=0x0002,RECEIVER". 
 
By defining "MAC_ADDR=0x0002", the MAC short address of the receiver is set 
to "0002". 
By defining "RECEIVER", the receiver is set to “receiver mode” as soon as the 
program starts.  
 
Click the rebuild button  or select "Build", then "Rebuild", to rebuild. 
Set the switches on the Receiver "78K0R UZ Stick" as shown below.  
 
 
 
 
 
 
Start the debugger, load the module file, and then run the program on the 
debugger, with referring to "3.9 Starting integrated debugger". 
Now, the receiver "78K0R UZ Stick" is standing by for receiving commands with 
wireless data from the transmitter. 
 
 
 

3). Preparation for Transmitter 
 
Next, you need to set for the transmitter "78K0R UZ Stick" and the PC.  
 
Set the switches on the transmitter "78K0R UZ Stick" as shown below.  
 
 
 
 
 
 
 
Connect USB cable to the second PC, which you do not use for debugging. 
Confirm the power LED is lighted.  
 
 
 
 

4). Hyper Terminal 
 
On MS-Windows in your PC, please select [All Programs] -> [Accessory] -> 
[Communication] -> [HyperTerminal] 
 

Switch Setting 
USB DBG 

POWER USB 

Switch Setting 
USB SER 

POWER USB 
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Setting of HyperTerminal 
  

 
 
 
 
 

 
 (Property -> Setting -> ASCII) 
 Local Echo OFF 
 No Line Feed 
 
 
If you are not sure about the COM port number, click "Start" -> "Settings" -> 
"Control Panel" -> "System" -> "Hardware" -> "Device Manager" and check the 
number at NEC Electronics Starter Kit Virtual UART" under "Ports (COM & LPT)". 
 

 
Press [ENTER] on your keyboard. 
Now you will find the following opening menu in the window. 

 
If the window is not displayed, check followings.  
  - Set the power switch of the transmitter "78K0R UZ Stick" to "BAT" once, then 

set back to "USB" again. 
  - Re-confirm the setting for the COM port of hyper terminal is correct.  
 

 
 

Bits per second 115200 

Data bits 8 

Parity None 

Stop bits 1 

Flow control None 
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5). Execution of the Transmit/Receive Test 
 
To initiate the PER, Packet Error Rate, test, please press “1” in the menu. You will 
see [My Profile], 
then, be asked for the destination of the PER test, as shown below. 
 

 

 
 
Now, you may input “0002”. 
Then, you will be asked how many packets you wish to consume in the PER test. 
You may input “1000”. 
Then, you will be asked the interval of packets in msec. 
You may input 3 msec. 
Then, the PER test will be executed.  
You will see, 
the number of packets sent, that is, 1000 as you input, 
the number of the received packets, 
the calculated PER in % 
and the maximum and minimum RSSI values in the PER test. 
 
[Note]  
PER= Packet Error Rate 
RSSI= Received Signal Strength Indication 
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RSSI is expressed in the hexagonal value of 256 levels, which indicates the signal 
strength in the received signal. For more details of the RSSI value, please refer to 
the datasheet of the UZ2400 RF chip. 
 
Please note the PER and the RSSI are measured at the receiver side. 
The receiver does not send back the test packets, but only the test result. 
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6). Channel setting 
 
In the previous example, you may have also found the RF channel used in this 
test is the Channel 11. The channel is specified by the IEEE 802.15.4 
specification. 
The channel 11 is assigned at 2405 MHz. You can change the channel in the PER 
test in 5MHz step to the maximum channel of 26th at 2480 MHz. 
To do it, please press “9” in the command prompt. Then, please choose the 
channel by [+], [-], [A], [B], or [C]. In the example below, the channel 23th, 2465 
MHz, was selected.  
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To execute the PER test at the channel 23, press [Enter] in your keyboard, then, 
choose “1” to initiate the PER test mode. Then, you may input 1000 packet in 5 
msec interval to see the following example. Please confirm the channel used is 
23th in the display. Please note the receiver will learn which channel is to be used 
for the test automatically. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

[My Profile] 
------------------------------------- 
  MAC : 22:95:78:01:00:00:00:47 
Short : 0001 
PanID : 2514 
------------------------------------- 
Send to (Short addr) ? : 02 
Send count (dec)     ? : 1000 
Interval (dec/msec)  ? : 5 
[Set channel to 11 (Cmd)] 
Prepare to send..OK 
[Set channel to 23 (Current)] 
Send..     0 
Request to result..OK 
 
 
[Results] 
------------------------------------- 
From     : 0001 
To       : 0002 
------------------------------------- 
Sent     : 1000 
Recieved : 1000 
PER      :   0.0000% 
RSSI     : max FF / min FF 
------------------------------------- 
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7). Adjusting the output power 
 

You may wish to control the output power in the PER test.  
For it, please select “0” in the menu. 
You will be asked the register ID. Please input “203”. 
Then you will see, “LREG[203] : 00 >”. 
It means the current value at the register [203] is 0x00h, which means 0 dB. 
0x00h is the reset default. 
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The register bits are defined as follows, 
 
LREG[203]:  

[7:6] -> large scale tuning 
 00: 0 dB  
01: -10 dB 
10: -20 dB 
11: -30 dB 
[5:3] -> small scale tuning 
000: 0 dB 
001: -1.25 dB 
010: -2.5 dB 
011: -3.75 dB 
100: -5 dB 
101: -6.25 dB 
110: -7.5 db 
111: -8.75 dB 
[2:0] -> 000 

 
For instance, if you wish -15 dB, please input “60”, as follows, 
 
“LREG[203] : 00 > 60”  
 
Then, you will start the PER test. 
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The minimum output power is set by “F8”. 
 

 
 
 
You may find larger PER value with smaller RSSI value in this case. 
 

 
 
Please note this adjustment is applied only to the transmitter. The receiver 

always sends back the test results with the 0 dB output power using the channel 
11th. 
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3.14.2 PER test / receiver 
 
The Menu 2 sets the 78K0R UZ Stick to the receiver in the PER test. 
If you have two PCs, you can connect two 78K0R UZ Stick to each of two 
PCs, then, you will apply this mode to one of them.  
In your current case, your receiver board is now being connected to the 
debugger. Therefore, you cannot access to these menu to utilize this mode 
setting. Alternatively, you have set the receiver 78K0R UZ Stick to the 
receiver mode by setting the compiler option. 
 

3.14.3 Continuous TX / Pseudo Noise 
 

The Menu 3 initiates the modulated RF transmission. The data carried are 
pseudo random numbers. You can define the channel using the menu 9, 
and the output power using the menu 0. 

 
 

3.14.4  Continuous TX / Raw carrier 
 

The Menu 4 initiates the carrier transmission. The output power is not 0 dB 
as a reset default. You can define the channel using the menu 9. 

 

3.14.5 RX Mode 
 

The Menu 5 initiates the receiver mode. 
 

3.14.6 IDLE MODE 
 

The Menu 6 sets the UZ2400 into the IDLE mode. 
 

3.14.7 Sleep MODE 
 

The Menu 7 sets the UZ2400 into the Deep Sleep mode. 
 

 

3.14.8 Standby MODE 
 

The Menu 8 sets the UZ2400 into the Standby mode. 
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3.14.9 Set RF channel 
 

The Menu 9 allows you to set the RF channel. 
 
 

3.14.10 Manually set UZ2400 register 
 
The Menu 0 allows you to set the UZ2400 registers. 
Please refer to the datasheet of the UZ2400 RF chip for the definition of 
registers. 

 
 

3.14.11 Resetting RF 
 

The Menu A allows you to reset the UZ2400 registers. 
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3.15 Creating a new PM + workspace (project) 
 
 
 
You may wish to create a new work space in the PM + to initiate a new project. 
Please select select [File]→[New Workspace...] in the pull-down menu of the PM 
+.  

  

 

 

  

            

 

The dialog box for creating 

New workspace is displayed

<Description of items> 

Workspace File Name: 
 -> Specify the name of the workspace file that 

manages the project files. 
.prw is automatically suffixed as the file 
type. 
A project file (.prj) of the same name is 
simultaneously created. 

Folder: 
 -> Specify the folder for saving the workspace 

file by writing its absolute path. 
    This item can be selected from a reference 

dialog box by pressing the Browse…
button. 

Project Group Name: 
 -> Specify this item if wishing to manage 
multiple projects together in function units.
If nothing is specified, this item is the 
same as the workspace file name. 

Series Name: 
 -> Specify the series name of the device to be 

used. 

Device Name: 
 -> Specify the name of the device to be used.
 

The concrete information set here is 
described on the following pages 
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                                        Push the Next > button. 

 
 

 
 Push the Yes button. 

 
  

Push the Detail setting button   

 

Input the workspace information 
setting as follows. 

Workspace file name 
 → test 

Folder 
   C:¥test 

Project Group Name 
 → Don’t input this item. 

Series Name 
 → 78K0R 

Device Name 
 → uPD78F1146_64 
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Set the version of tools as follows. 
CC78K0R：W1.20 

RA78K0R：W1.10 

ID78K0R-QB：V3.40 

 

 

Select tools as above screenshot, then click  OK  . 

 

 
Click  Next >   

 

 
Click  Next >   
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Select ID78K0R-QB V3.40 

 
 

  
Click  Next >   

 

 

Click  Finish   

 

 

Check the project information 

setting contents. 
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This completes workspace and project creation. 
Additional source files can be registered at any time thereafter. 

For details, refer to ”Registering additional source file”  

 
Also, you need to do the settings for on-chip debug. Please refer to "2.4 Set Linker Options", 
"2.5 Set Compiler Options", and "2.7 Check Debugger Settings". 

 

 

 

Project “test" was registered. 
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3.16 Registering additional source file 

 
 

The method for registering additional source files to a project is described below. 
The following example shows the additional registration of source files “b.c” and “c.c” with 
source file “a.c” already registered. 
Place the cursor on the source file in the Project window of PM +, and select [Add Source 
Files…] displayed in the right-click menu  

 

 

 

 

Select source files “b.c” and “c.c” and 
then press the Open button. 

 

 Multiple source files can be selected by clicking the desired source files where pressing Ctrl key. 
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Source file “b.c” and “c.c” 
are additionally registered 
to the project. 
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3.17 Terminating PM + 
 
 
 
 

In the PM + menu, select [File]→[Save Workspace].  
Then, select [File]→[Close Workspace].  
 
In the PM + menu, select [File]→[Exit PM +].  

 

 

 

 
PM + ends. 
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4 IEEE 802.15.4 MAC Sample Program 
 

 
The sample implementations utilizing the MAC stack are offered in this evaluation 
kit.  
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The MAC Sample program :TextChat 
 
 
This chapter introduces the usage of MAC application 
 

The MAC Sample program is developed to provide with a simple example to 
construct a star network utilizing the IEEE 802.15.4 PHY/MAC standard. 
 
The MAC Sample Program offers, 

1. Designation of a network coordinator in a star configuration 
2. Text chat between a coordinator and an end device 

 
To use the MAC Sample Program, you need to prepare at least two PC with a 
USB interface or one PC with more than one USB interface, and two 78K0R 
UZ Stick.  
 
The MAC Sample Program 1 is provided in the form of the C source codes.  
 
If you wish to tailor the sample program to meet your specific needs, you can 
edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on to 
the microcontroller for further debugging on the project manager PM +. In this 
procedure, the Flash programmer is not required. However, because the 
USB connection to instruct operation to the program is occupied for the 
debugging purpose, alternatively, you can make a release build to achieve a 
new hex file, on the project manager PM +. 
 

As a general remark, please respect your local regulation of electro-magnetic 
RFssion. In general, it is suggested to use the 78K0R UZ Stick in a radio 
anechoic chamber. 
 
It supports text chat for one coordinator and 4 end devices. 
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4.1.1 Programming to the 78K0R UZ Stick 
 
For chatting, please prepare minimum 2, or maximum 5 78K0R UZ Stick. 
You need identical numbers of PCs. or one PC with more than one USB interface, 
 
Some laptop PCs do not support full functionality of hyperterminal. 
This software has been confirmed at 
 
NEC MATE MY25XCZEG  
and, NEC VERSAPRO VY10F/BH-M 
 
One 78K0R UZ Stick will be "Coordinator". Other 1-4 78K0R UZ Stick will be "End 
device". 
You use the same project files for both "Coordinator" and "End device". 
 
Start PM+, and open the file 
"C:¥TK78K0R¥SAMPLE_UZStick¥78K0RUZSTICK_MAC_Sample¥78K0RUZSTICK_M
AC_Sample.prw". 
 
Select "Tool" on menu bar, then "Compiler options..". 
Select "Preprocessor" tab on "Compiler Options" window. 
To write programs to the first 78K0R UZ Stick, enter 
"CPU78K0R,F114664,MAC_ADDR=0x0001" on "Define Macro". For the second and 
third 78K0R UZ Stick, enter "CPU78K0R, F114664,MAC_ADDR=0x0002" and 
"CPU78K0R, F114664,MAC_ADDR=0x0003". The number "x" of " MAC_ADDR=x" 
must be a unique number. 
 
Click rebuild button on PM+ or select "Build" -> "Rebuild" on menu bar to rebuild. 
 
Start the debugger from PM+, then write different programs to each 78K0R UZ Stick (for 
the information about how to write programs, refer to "3.1 Starting PM+" through "3.9 
Starting integrated debugger").) 
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4.1.2 Setting up the 78K0R UZ Stick to your PC 
 
Set the 78K0R UZ Stick as shown below. Then, connect to USB interface on the PC. 
 
 
 
 
 
Start Hyper Terminal with referring to "3.14 RF Test Program". 
 
Settings of the Hyper Terminal should be set as follows 

 
 
 
 
 

 
When the Hyper Terminal starts, run the sample application by setting the POWER switch to 
USB.  
 
In the same way, connect the other 78K0R UZ Stick to PC, and start Hyper Terminal. If the 
PC has more than one USB ports, you can connect to more than one 78K0R UZ Stick, and 
you can start more than one Hyper Terminals for those COM ports on each 78K0R UZ Stick. 
 

Switch Setting 
USB SER 

POWER BAT 

Bits per second 115200 

Data bits 8 

Parity None 

Stop bits 1 

Flow control None 
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4). Hyper Terminal 
 

Now you will find the following opening menu in the window. 
If not, please try Power On Reset by switching the POWER switch to BAT, 
and, then, back to the USB position. 
 

 
 
Then, press Enter, 
 

 
 
Please do the same for your other 78K0R UZ Stick and PCs. 

<< 78K0R+UZ Sample Application: Skyley Networks >> 

My MAC extended address 

= 22950000100000047 

 

  Command > 

[Help] ------------------------- 

S: Send Message 

M: MLME Associate test 

C: Start Coordinator test 

-------------------------------- 

 

Command? > 
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4.1.3 Designation of a coordinator 
 

Now, you must decide which 78K0R UZ Stick is a coordinator. 
Go to the PC of the coordinator, and press C. 
 

 
 
Now the coordinator has started. 

 

4.1.4 Network Association 
 

For other PCs for other 78K0R UZ Stick, please press M. 
 

 
 
Now, this particular 78K0R UZ Stick was associated to the network as an 
end device with the short address of 4321. Please repeat this step for your 
third, fourth, and possibly fifth 78K0R UZ Stick. 
 

Command? >M 

 

> MLME-ASSOCIATE.request 

> MLME-ASSOCIATE.confirm 

>  Associated ShortAddr:4321 

>                Status:00 

 

Command? > 

Command? >C 

 

> MLME-START.request 

> MLME-START.confirm 

>  Status:00 

 

Command? > 
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On the coordinator side, you will find the following message, if the 
association is successful. 
 

 
 

 

4.1.5 Text Chat 
 

Now the network is prepared for you to start text chat between an end 
device and the coordinator. 
 
At first, you may start with the coordinator. 
 
Press S, then input the short address of an end device, 4321 in this 
example, 
then, input your text message, up to 102 bytes.  
 

 
 
 

 

Command? >S 

 

> MCPS-DATA.request 

> Send to (short address) ? 4321 

> Message ? Hello! 

 

Command? > 

> MLME-ASSOCIATE.indication 

>  from 2295000200000047 associated to 4321 

 

[Help] ------------------------- 

S: Send Message 

-------------------------------- 

 

Command? > 
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You will find the following message on the end device, 4321. 
The sender’s short address is “1975”, and the PAN ID is 2420 in this 
example. 
 

 
 
Now, you can reply from the end device “4321” to the coordinator “1975” by 
inputting S, 1975, and your reply text. 
 
 

 
 
 

Command? > 

> MCPS-DATA.indication 

>  from 1975/2420 

Hello! 
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5 Mode setting of the 78K0R UZ Stick 
 

 
 
 
The combination table of the switch of the 78K0R UZ Stick is shown. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Usage case 
 
Switch 

Normal 
（USB Power Supply）

Normal  
（Battery Power 

Supply） 

Debug   
(USB Connection) 

USB SER SER DBG 
POWER USB BAT USB 

 
CAUTION 

Disconnect the USB cable from the PC when you need to change to Normal use, 
after Debug use.  

 
 

POWER 

USB 
DBG SER 

USB BAT 
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6 Revision History 
 
 
 
 

Revision  Contents Date 
Rev. 1.0 Initial Version April 7, 2007 
Rev. 2.0 Correction with the sample program 

change. 
May 29, 2007 

Rev. 3.0 Correction with the sample program 
change. 

March 31, 2008 

Rev. 3.1 Manufacturer change June 20, 2008 
Rev. 4.0 Correction with the sample program 

change. 
March 09, 2009 

 


